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SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.



© Copyright 2010 Hewlett-Packard
Development Company, L.P.

Bluetooth is a trademark owned by its
proprietor and used by Hewlett-Packard
Company under license. Intel and Atom are
trademarks of Intel Corporation in the U.S.
and other countries. Microsoft and Windows
are U.S. registered trademarks of Microsoft
Corporation. SD Logo is a trademark of its
proprietor.

The information contained herein is subject
to change without notice. The only
warranties for HP products and services are
set forth in the express warranty statements
accompanying such products and services.
Nothing herein should be construed as
constituting an additional warranty. HP shall
not be liable for technical or editorial errors
or omissions contained herein.

First Edition: January 2010

Document Part Number: 602516-001
Revision A



Safety Warning Notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the air vents. Use the computer only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description Compaq
Mini
CQ10

Compaq
Mini 102

Product name Compaq Mini CQ10 Noteook PC ✓  

Compaq Mini 102 Notebook PC  ✓

Processor Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-
side bus (FSB)

✓ ✓

Chipset Northbridge: 945GSE; 533-MHz bus speed ✓ ✓

Southbridge: ICH7M ✓ ✓

Graphics Intel® Graphics Media Accelerator 950 ✓ ✓

Universal Memory Architecture (UMA) graphics subsystem ✓ ✓

Panels 25.7-cm (10.1-in) WSVGA (1024 × 600) AntiGlare LED

NOTE: Display assembly includes 1 webcam, 1 microphone, 2 speakers,
and 2 wireless local-area network (WLAN) antennas and cables; 2 wireless
wide-area network (WWAN) antennas and cables and a 5-band WWAN
antenna and cable on select models

✓ ✓

Wide aspect 16:9 ratio ✓ ✓

Memory DDR2 PC2-6400, 533-MHz memory module ✓ ✓

One customer-accessible/upgradable memory module slot ✓ ✓

Supports the following configurations:   

● 1024-MB total system memory (1024 × 1) ✓ ✓

● 2048-MB total system memory (2048 × 1)

NOTE: The computer is only available with 1 GB of memory, but supports
up to 2 GB of single channel memory.

✓  
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Category Description Compaq
Mini
CQ10

Compaq
Mini 102

Mass storage
devices

Hard drive ✓ ✓

● 9.5-mm, 6.35-cm (2.50-in) ✓ ✓

● 160 GB, 5400 RPM ✓ ✓

● Serial ATA ✓ ✓

Solid-state drive (SSD)

NOTE: For use with XP Home Edition only.

 ✓

● 16 GB, 6.35 cm (2.5 in)  ✓

● Multi-level cell (MLC) technology  ✓

● Serial ATA  ✓

Optical drive Supports external USB optical drives only ✓ ✓

Diskette drive Supports external USB diskette drives only ✓ ✓

Audio/Visual High-definition (HD) audio ✓ ✓

Integrated 4-Ω, 1.5-W speakers (2) ✓ ✓

Fixed integrated analog microphone ✓ ✓

Fixed VGA webcam, 640 × 480 resolution, ƒ/2.8, up to 30 frames per
second

✓ ✓

Modem Supports external USB modems only ✓ ✓

Ethernet Integrated Atheros® AR8132 PCI-E 10/100BASE-T Ethernet controller ✓ ✓

Wireless Integrated wireless local area network (WLAN) and Bluetooth®
options by way of optional WLAN module:

✓ ✓

Two WLAN antennas built into display assembly ✓ ✓

Support for the following WLAN formats:   

● 802.11b/g ✓ ✓

● 802.11b/g/n ✓ ✓

● 802.11b/g with Bluetooth ✓ ✓

Support for No WLAN option ✓ ✓

Integrated wireless wide area network (WWAN) options by
way of optional WWAN module:

✓ ✓

Two WWAN antennas built into display assembly ✓ ✓

Support for 5-band WWAN antenna option ✓ ✓

Subscriber identity module (SIM) security (customer-accessible in battery bay) ✓ ✓

Support for No WWAN option ✓ ✓
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Category Description Compaq
Mini
CQ10

Compaq
Mini 102

External media
cards

Digital Media Slot with push-push insert/eject port supporting:

● Memory Stick (MS)

● MS/Pro

● MultiMediaCard (MMC)

● Secure Digital High Capacity (SDHC) memory card

● xD-Picture Card

✓ ✓

Internal media
cards

Two Mini Card slots:

● Full-size Mini Card slot

● Half-size Mini Card slot

✓ ✓

Ports Audio-in/out (microphone/stereo headphone) with jack detection ✓ ✓

VGA (D-sub 15) supporting external 1600 × 1200 monitor at 75 Hz and
external WUXGA monitor at 60 Hz (hot plug/unplug with auto-detect of
standard- or wide-aspect video)

✓ ✓

RJ-45 (Ethernet, includes link and activity lights) ✓ ✓

USB (3) ✓ ✓

3-pin AC power ✓ ✓

Keyboard/
pointing device

92% keyboard ✓ ✓

TouchPad, with 2 TouchPad buttons and 2-way scrolling (taps enabled by
default)

✓ ✓

Power
requirements

30-W UMA AC adapter (non-Smart) with localized cable plug support ✓ ✓

AC adapter connector on cable ✓ ✓

6-cell Li-ion battery (55-Wh) 2.55-Ah, 6-hour target life ✓ ✓

3-cell Li-ion battery (28-Wh) 2.55-Ah , 3-hour target life ✓ ✓

Security Support for HP Kensington Security Lock ✓ ✓

Operating
system

Preinstalled:   

● Windows XP Home Edition SP3 ✓ ✓

● Windows 7 Starter 32 ✓  

● FreeDos  ✓
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Category Description Compaq
Mini
CQ10

Compaq
Mini 102

Serviceability End-user replaceable parts:   

AC adapter ✓ ✓

Battery (system) ✓ ✓

Keyboard ✓ ✓

Hard drive ✓ ✓

Solid state drive ✓

Memory modules ✓ ✓
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2 External component identification

Components included with the computer may vary by region and model. The illustrations in this chapter
identify the standard features on most computer models.

Top components
TouchPad

Component Description

(1)  Left TouchPad button* Functions like the left button on an external mouse.

(2)  TouchPad* Moves the pointer and selects or activates items on the
screen.

(3)  TouchPad scroll zone Scrolls up or down.

(4)  Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel >
Printers and Other Hardware > Mouse.
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Light

Component Description

Caps lock light On: Caps lock is on.
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Keys

Component Description

(1)  Function keys Execute frequently used system functions when
pressed in combination with the fn key.

(2)  fn key Executes frequently used system functions when
pressed in combination with a function key.

(3) Windows® logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the
pointer.
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Front components

Component Description

(1) Power light ● On: The computer is on.

● Blinking: The computer is in Standby.

● Off: The computer is off or in Hibernation.

(2)  Power switch ● When the computer is off, slide the switch to
turn on the computer.

● When the computer is on, briefly slide the
switch to initiate Hibernation.

● When the computer is in Standby, briefly slide
the switch to exit Standby.

● When the computer is in Hibernation, briefly
slide the switch to exit Hibernation.

If the computer has stopped responding and
Windows shutdown procedures are ineffective, slide
and hold the power switch for at least 5 seconds to
turn off the computer.

To learn more about your power settings, select
Start > Control Panel > Performance and
Maintenance > Power Options.

(3) Drive light Blinking: The hard drive or flash drive is being
accessed.

(4) Battery light ● On: A battery is charging.

● Blinking: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery
level, the battery light begins blinking rapidly.

● Off: If the computer is plugged into an external
power source, the light turns off when all
batteries in the computer are fully charged. If
the computer is not plugged into an external
power source, the light stays off until the battery
reaches a low battery level.
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Component Description

(5) Wireless light ● Blue: An integrated wireless device, such as a
wireless local area network (WLAN) device, is
on.

● Amber: All wireless devices are off.

(6)  Wireless switch Turns the wireless feature on or off, but does not
establish a wireless connection.

NOTE: A wireless network must be set up in order
to establish a wireless connection.
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Right-side components

Component Description

(1) USB ports (2) Connect optional USB devices.

(2)  Digital Media Slot Supports the following optional digital card formats:

● Memory Stick (MS)

● MS/Pro

● MultiMediaCard (MMC)

● Secure Digital High Capacity (SDHC) Memory
Card

● xD-Picture card

(3) External monitor port Connects an optional external display, such as a
monitor or projector, to the computer.

(4) RJ-45 (network) jack Connects a network cable.
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Left-side components

Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from
being mishandled or stolen.

(2) Power connector Connects an AC adapter.

(3)  AC adapter light On: The computer is connected to external power.

Off: The computer is not connected to external
power.

(4)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It
is normal for the internal fan to cycle on and off
during routine operation.

(5) USB port Connects an optional USB device.

(6) Audio-out (headphone) jack/Audio-in (microphone)
jack

Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio. Also connects an optional headset
microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety
information, refer to the Regulatory, Safety and
Environmental Notices.

NOTE: When an audio component is connected to
the jack, the computer speakers are disabled.

The audio component cable must have a 4-conductor
connector.
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Display components

Component Description

(1) Speakers (2) Produce sound.

(2) Internal display switch Turns off the display if the display is closed while the
power is on.

NOTE: The display switch is not visible from the
outside of the computer.

(3) Webcam Captures still photographs and videos.

NOTE: To capture videos, you need to install
additional webcam software.

(4) Webcam light On: The webcam is in use.

(5) Internal microphone Records sound.
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Bottom components

Component Description

(1)  Battery bay Holds the battery.

(2) Battery release latches (2) Release the battery from the battery bay.

(3)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4) Memory module compartment Contains the memory module slot.

Bottom components 13



Wireless antennas

Component Description

(1) WWAN antennas (2) (select models only)* Send and receive wireless signals to communicate with wireless
wide-area networks (WWANs).

(2) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLANs).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. To access these notices, click Start > Help and
Support > User Guides.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial: This is an alphanumeric identifier that is unique to each product.

(3) Product: This number provides specific information about the product's hardware components. The
product number, or part number, helps a service technician determine what components and parts are
needed.

(4) Warranty: This number describes the duration of the warranty period for the computer.

(5) Model: This is the alphanumeric identifier used to locate documents, drivers, and support for the
computer.

NOTE: The Warranty (4) and the Model (5) fields are excluded on select models.

NOTE: The service tag color may be different on select models.
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Computer major components

Item Description Spare part
number

(1) Display assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare 

(includes 1 webcam, 1 microphone, 2 speakers, and 2 WLAN antennas/cables; WWAN
antennas/cables on select models

See Display assembly subcomponents on page 21 for a comprehensive list of display
assembly components.

594806-001
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Item Description Spare part
number

(2) Keyboard

● For use in Brazil 535689-202

● For use in the Czech Republic 535689-221

● For use in Europe 535689-A41

● For use in Finland, Norway, and Sweden 535689-DH1

● For use in France 535689-051

● For use in French Canada 535689-121

● For use in Germany 535689-041

● For use in Greece 535689-DJ1

● For use in Hungary 535689-211

● For use with international models 535689-B31

● For use in Israel 535689-BB1

● For use in Italy 535689-061

● For use in Latin America 535689-161

● For use in Portugal 535689-131

● For use in Russia 535689-251

● For use in Slovenia 535689-BA1

● For use in Spain 535689-071

● For use in Saudi Arabia 535689-171

● For use in Switzerland 535689-BG1

● For use in Turkey 535689-141

● For use in the United Kingdom 535689-031

● For use in the United States 535689-001

(3) Top cover with TouchPad 537622-001

(4) Mass storage devices

NOTE: Each hard drive mounts in the computer using a bracket and screws included in the mounting kit.

See Mass storage devices on page 44 for the mounting kit part number.

● Hard drive, 160-GB, 5400-RPM 594809-001

NOTE: Hard drive mounting kit not detailed. 537641-001

● Solid state drive, 16 GB 608396-001

(5) Heat sink assembly (includes replacement thermal material) 537619-001

(6) Fan 537613-001
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Item Description Spare part
number

(7) USB/audio board (includes cable) 600124-001

(8) DC connector/power board 581326-001

 Plastics/actuator kit

Includes the following:

537612-001

(9a) ● Power switch and wireless switch actuators  

(9b) ● Memory module compartment cover  

(9c) ● Bezel for Digital Media slot  

(10) WLAN modules  

Broadcom 4312G 802.11b/g WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

575920-001

Broadcom 43225 802.11b/g/n 2x2 WiFi Adapter 593837-001

Atheros AR9285 802.11b/g/n 1x1 WiFi Adapter  

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

518436-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos,
Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
the People's Republic of China, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates,
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

518436-002
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Item Description Spare part
number

 Broadcom 4312G 802.11b/g WiFi Adapter

● For use for use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States,
and the U.S. Virgin Islands

504593-003

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos,
Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
the People's Republic of China, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates,
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

504593-004

(11) WWAN Module, Qualcomm EV-DO/HSPA 

NOTE: Available as an option.

531993-001

(12) RTC battery (includes cable and double-sided tape) 537616-001

(13) System board (includes processor and replacement thermal material)  

● Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus
(FSB)

594804-001

● Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus
(FSB) for use with WWAN option

599187-001

(14) Memory module  

● 1024-MB, PC2-6400, DDR2, 533-MHz 598861-001

● 1024-MB, PC2-6400, DDR2, 533-MHz, for use with WWAN option 600131-001

(15) Base enclosure (includes 4 rubber feet) 594810-001
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Item Description Spare part
number

(16) Battery  

● 6-cell Li-ion battery (55-Wh) 2.55-Ah 537627-001

● 3-cell Li-ion battery (28-Wh) 2.55-Ah 537626-001
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Display assembly subcomponents

Item Description Spare part number

(1) EMI shield and hinge covers 537617-001

(2) Display bezel with logo for use with webcam and microphone 537644-001

(3) Display hinge kit

(Includes left and right display panel hinges)

537658-001

(4) Speaker assembly 

Includes 2 speakers, cable, and housing

594811-001

(5) Display panel, 25.7-cm (10.1-in) WSVGA (16:9), non-PMMA, AntiGlare 600125-001

(6) Webcam module 537660-001

Display cable kit (not illustrated)

Includes:

579571-001

(7a) ● Display/webcam cable  

(7b) ● WLAN antenna assembly (530 × 1.37 mm and 440 × 1.37 mm)  

(8) Microphone assembly (44 dB, 4.9 × 2.2, omnidirectional) 581323-001

(9) WWAN antenna assembly for use on select models 538022-001
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Item Description Spare part number

(10) Display back cover with logo 594808-001

 Display screw kit (not illustrated)

Includes 14 PM2.0×3.0×4.0×0.4T screws

538510-001
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Mass storage devices

NOTE: Each hard drive spare part kit and solid-state drive spare part kit includes a cable and
mounting bracket.

Item Description Spare part number

(1) Hard drive, 160 GB, 5400 RPM 594809-001

 Hard drive mounting kit (includes brackets and screws) 537641-001

(2) Solid state drive, 16 GB 608396-001
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Miscellaneous parts
Description Spare part number

30-W, 3-pin AC adapter 496813-001

Power cords, 3-pin, 1.83m

● For use in Argentina 490371-D01

● For use in Australia 490371-011

● For use in Brazil 490371-202

● For use in Denmark 490371-081

● For use in Europe 490371-021

● For use in Israel 490371-BB1

● For use in Italy 490371-061

● For use in India 490371-D61

● For use in North America 490371-001

● For use in Singapore and the United Kingdom 490371-031

● For use in South Africa 490371-AR1

● For use in Switzerland 490371-111

Rubber kit 

Includes 4 computer feet — two front and two rear

537618-001

Screw kit

Includes the following screws:

● Phillips 1.6×2.5 mm, nickel

● Phillips 2.0×3.5 mm

● Phillips 2.5×4.0 mm, black

● Phillips 2.5×4.0 mm, nickel

● Phillips 2.5×6.0 mm

● Torx T8 2.5×4.0 mm

537620-001
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Sequential part number listing
Spare part number Description

490371-001 Power cord, 3-pin, 1.83m, for use in North America

490371-011 Power cord, 3-pin, 1.83m, for use in Australia

490371-021 Power cord, 3-pin, 1.83m, for use in Europe

490371-031 Power cord, 3-pin, 1.83m, for use in Singapore and the United Kingdom

490371-061 Power cord, 3-pin, 1.83m, for use in Italy

490371-081 Power cord, 3-pin, 1.83m, for use in Denmark

490371-111 Power cord, 3-pin, 1.83m, for use in Switzerland

490371-202 Power cord, 3-pin, 1.83m, for use in Brazil

490371-AR1 Power cord, 3-pin, 1.83m, for use in South Africa

490371-BB1 Power cord, 3-pin, 1.83m, for use in Israel

490371-D01 Power cord, 3-pin, 1.83m, for use in Argentina

490371-D61 Power cord, 3-pin, 1.83m, for use in India

496813-001 AC adapter, 30-W, 3-pin

504593-003 WiFi Adapter, Broadcom 4312G 802.11b/g for use for use in Canada, the Cayman Islands, Guam,
Puerto Rico, the United States, and the U.S. Virgin Islands

504593-004 WiFi Adapter, Broadcom 4312G 802.11b/g for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People’s Republic of China, Peru,
the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain,
Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518436-001 WiFi Adapter, Atheros 9285G 802.11b/g/n 1x1 for use in Canada, the Cayman Islands, Guam,
Puerto Rico, the U.S. Virgin Islands, and the United States
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518436-002 WiFi Adapter, Atheros 9285G 802.11b/g/n 1x1 for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People’s Republic of China, Peru,
the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain,
Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

531993-001 WWAN module, Qualcomm EV-DO/HSPA

535689-001 Keyboard for use in the United States

535689-031 Keyboard for use in the United Kingdom

535689-041 Keyboard for use in Germany

535689-051 Keyboard for use in France

535689-061 Keyboard for use in Italy

535689-071 Keyboard for use in Spain

535689-121 Keyboard for use in French Canada

535689-131 Keyboard for use in Portugal

535689-141 Keyboard for use in Turkey

535689-161 Keyboard for use in Latin America

535689-171 Keyboard for use in Saudi Arabia

535689-202 Keyboard for use in Brazil

535689-211 Keyboard for use in Hungary

535689-221 Keyboard for use in the Czech Republic

535689-251 Keyboard for use in Russia

535689-A41 Keyboard for use in Europe

535689-B31 Keyboard for use with international models

535689-BA1 Keyboard for use in Slovenia

535689-BB1 Keyboard for use in Israel
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535689-BG1 Keyboard for use in Switzerland

535689-DH1 Keyboard for use in Finland, Norway, and Sweden

535689-DJ1 Keyboard for use in Greece

537612-001 Plastics/actuator kit

537613-001 Fan

537616-001 RTC battery (includes cable and double-sided tape)

537617-001 EMI shield and hinge covers

537618-001 Rubber kit with 4 computer feet — two front and two rear

537619-001 Heat sink assembly (includes replacement thermal material)

537620-001 Screw kit

537622-001 Top cover with TouchPad

537626-001 Battery, 3-cell Li-ion battery (28-Wh) 2.55-Ah

537627-001 Battery, 6-cell Li-ion battery (55-Wh) 2.55-Ah

537641-001 Hard drive mounting kit (includes mounting bracket and 4 PM3.0×3.0×4.5 screws)

537644-001 Display bezel with Compaq logo for use with webcam and microphone

537658-001 Display hinge kit (includes left and right display panel hinges)

537660-001 Webcam module

538022-001 WWAN antenna assemblies (optional)

538510-001 Display screw kit

575920-001 Broadcom 4312G 802.11b/g WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter

579571-001 Display cable kit (not illustrated, includes display/webcam cable and WLAN antennas)

581323-001 Microphone assembly (44 dB, 4.9 × 2.2, omnidirectional)

581326-001 DC connector/power board

593837-001 Broadcom 43225 802.11b/g/n 2x2 WiFi Adapter

594804-001 System board, Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus
(FSB)

594806-001 Display, 25.7-cm (10.1-in), WSVGA, AntiGlare for use with WWAN

594808–001 Display back cover with logo

594809-001 Hard drive, 160-GB, 5400-RPM

594810-001 Base enclosure

594811-001 Speaker assembly (includes two 4-ohm speakers, cable, and housing)

598861-001 Memory module, 1024-MB, PC2-6400, DDR2, 533-MHz

599187-001 System board, Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus
(FSB) for use with WWAN option
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600124-001 USB/audio board with cable

600131-001 Memory module, 1024-MB, PC2-6400, DDR2, 533-MHz, for use with WWAN option

600125-001 Display panel, 25.7-cm (10.1-in), WSVGA, non-PMMA, AntiGlare

608396-001 Solid state drive, 16 GB
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4 Removal and replacement
procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 54 screws, in 8 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

NOTE: The service tag color may be different on select models.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial: This is an alphanumeric identifier that is unique to each product.

(3) Product: This number provides specific information about the product's hardware components. The
product number helps a service technician determine what components and parts are needed.

(4) Warranty: This number describes the duration of the warranty period for the computer.

(5) Model: This is the alphanumeric identifier used to locate documents, drivers, and support for the
computer.

NOTE: The Warranty (4) and the Model (5) fields are excluded on select models.
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Computer feet
The computer feet are adhesive-backed rubber pads, tethered to the base enclosure.

Description Spare part number

Rubber kit 537618-001
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Battery

Description Spare part number

6-cell Li-ion battery (55-Wh) 2.55-Ah 537627-001

3-cell Li-ion battery (28-Wh) 2.55-Ah 537626-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2).

Reverse this procedure to install a battery.
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SIM
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to insert the SIM.
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Memory module

Description Spare part number

1024-MB memory module (PC2-6400, DDR2, 533-MHz) 598861-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

Remove the memory module:

1. Loosen the 2 Phillips PM2.0×3.0 captive screws (1) that secure the memory module compartment
cover to the computer.

2. Swing the cover up and away from the inside of the computer (2), and then remove the cover (3).

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Keyboard

Description Spare part number

Keyboard for use in Brazil 535689-202

Keyboard for use in Europe 535689-A41

Keyboard for use in Finland, Norway, and Sweden 535689-DH1

Keyboard for use in France 535689-051

Keyboard for use in French Canada 535689-121

Keyboard for use in Germany 535689-041

Keyboard for use in Greece 535689-DJ1

Keyboard for use in Hungary 535689-211

Keyboard for use in Israel 535689-BB1

Keyboard for use in Italy 535689-061

Keyboard for use in Latin America 535689-161

Keyboard for use in Portugal 535689-131

Keyboard for use in Russia 535689-251

Keyboard for use in Saudi Arabia 535689-171

Keyboard for use in Slovenia 535689-BA1

Keyboard for use in Spain 535689-071

Keyboard for use in Switzerland 535689-BG1

Keyboard for use in the Czech Republic 535689-221

Keyboard for use in the United Kingdom 535689-031

Keyboard for use in the United States 535689-001

Keyboard for use in Turkey 535689-141

Keyboard for use with international models 535689-B31

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).
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Remove the keyboard:

1. Remove the 3 Phillips PM2.0×3.0 screws that secure the keyboard to the computer.

2. Turn the computer right-side up, and then open the display as far as possible.

3. Turn the computer upside down, and locate the keyboard release access on the bottom of the
computer, inside the battery bay.

4. Insert a flexible tool into the opening, and then press inward to release the keyboard.

5. Turn the computer right-side up, and then lift up on the top and left edges (1) of the keyboard until
the keyboard releases completely.
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6. Slide the keyboard back until its top edge rests on the display assembly (2).

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached.

8. Disconnect the cable (2), and then remove the keyboard.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.

42 Chapter 4   Removal and replacement procedures



RTC battery

Description Spare part number

RTC battery 537616-001

Before removing the real-time clock (RTC) battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the Keyboard (see Keyboard on page 40).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the system board.

NOTE: The RTC battery is attached to the system board with double-sided tape.

Reverse this procedure to install the RTC battery.
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Mass storage devices
NOTE: Each hard drive spare part kit and solid state drive spare part kit includes a bracket and
screws.

Description Spare part number

Hard drive, 160 GB, 5400 RPM 594809-001

Hard drive mounting kit 537641-001

Solid state drive, 16 GB 608396-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the keyboard (see Keyboard on page 40).

To remove the hard drive or the solid state drive:

1. Loosen the Phillips PM2.5×10.0 captive screw (1), and remove the 2 Phillips PM2.0×3.0 screws
 (2) that secure the assembly to the computer.

2. Use the Mylar tab to slide the assembly to the left (3) to disconnect it, and remove the
assembly (4).

Continue with one of the following sections for hard drive or solid-state drive replacement.
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Hard drive

1. Remove the 4 Phillips PM3.0×3.0 screws (1) that secure the hard drive bracket to the hard drive.

2. Using the Mylar tab, lift the bracket (2) away from the hard drive.

Reverse this procedure to install a hard drive.

Solid-state drive

To remove the solid-state drive:

1. Remove the 4 Phillips PM2.0×3.0 screws (1) that secure the solid-state drive bracket to the solid-
state drive.

2. Lift the solid-state drive (2) to remove it.

Reverse this procedure to install a solid-state drive.
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Top cover

Description Spare part number

Top cover with TouchPad 537622-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the memory module (see Memory module on page 38).

7. Remove the keyboard (see Keyboard on page 40).

8. Remove the hard drive assembly (see Mass storage devices on page 44).

Remove the top cover.

1. Turn the computer upside down, with the front toward you.

2. Use a thin, flat tool to release the 4 rubber feet.

3. Remove the 4 Phillips PM2.5×6.0 screws (1), and the Phillips PM2.0×4.0 screw (2) that secure
the top cover to the base enclosure.

4. Turn the computer right-side up, with the front toward you.

5. Open the computer as far as possible.

46 Chapter 4   Removal and replacement procedures



6. Remove the 8 Phillips PM2.5×6.0 screws  that secure the top cover to the base enclosure.

7. Lift the inside edge of the top cover (1) and swing it up. Then slide the top cover back slightly to
rest against the display assembly (2) at an angle.

8. Release the ZIF connector (1) to which the TouchPad button board cable is connected.
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9. Disconnect the TouchPad button board cable (2) from the system board, and then remove the top
cover.

Reverse this procedure to install the top cover.
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WLAN module

Description Spare part number

Broadcom 4312G 802.11b/g WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter 575920-001

Broadcom 43225 802.11b/g/n 2x2 WiFi Adapter 593837-001

Atheros 9285G 802.11b/g/n 1x1 WiFi Adapter  

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

518436-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon,
Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
the People's Republic of China, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518436-002

Broadcom 4312G 802.11b/g WiFi Adapter 
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Description Spare part number

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

504593-003

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon,
Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
the People's Republic of China, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
computer functionality, and then contact technical support through Help and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).
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5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive (see Mass storage devices on page 44)

c. Top cover (see Top cover on page 46)

Remove the WLAN module:

1. Remove the 2 Phillips PM2.0×3.0 screws (1) that secure the WLAN module to the system board.
(The edge of the module opposite the slot rises away from the computer.)

2. Disconnect the wireless antenna cables (2) from the terminals on the WLAN module.

3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

Reverse this procedure to install the WLAN module.
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WWAN module
NOTE: Not available for computers with Mobile Mi installed.

Description Spare part number

Qualcomm EV-DO/HSPA WWAN module 531993-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that regulates wireless devices in your country or
region. If you replace the module and then receive a warning message, remove the module to restore
computer functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the SIM (see SIM on page 37).

6. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive or solid-state drive (see Mass storage devices on page 44)

c. Top cover (see Top cover on page 46)

Remove the WWAN module:

1. Remove the 2 Phillips PM2.0×3.0 screws (1) that secure the WWAN connector module (3) to the
system board. (The edge of the module opposite the slot rises away from the computer.)

2. Disconnect the wireless antenna cables (2) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

Reverse this procedure to install the WWAN module.
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USB/audio board

Description Spare part number

USB/audio board (includes cable) 600124-001

Before removing the USB/audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC Adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the following components:

a. Keyboard (see Keyboard on page 40).

b. Hard drive (see Mass storage devices on page 44).

c. Top cover (see Top cover on page 46).

Remove the USB board:

1. Release the ZIF connector (1) to which the USB/audio board cable is connected, and disconnect
the cable (2).

2. Release the USB/audio board from the clip attached to the base enclosure (3), and remove the
USB/audio board (4).

Reverse this procedure to install the USB/audio board.
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DC connector/power board

Description Spare part number

DC connector/power board 581326-001

Before removing the power/battery pass-through board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive (see Mass storage devices on page 44)

c. Top cover (see Top cover on page 46)

Remove the power/battery pass-through board:

1. Disconnect the power cable (1).

2. Remove the 2 Phillips PM2.5×4.0 screws (2) that secure the power/battery pass-through board to
the base enclosure.

3. Remove the power/battery pass-through board (3).

Reverse this procedure to install the power/battery pass-through board.
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Fan

Description Spare part number

Fan 537613-001

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-in) clearance on the left side of
the computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature
sensor and is designed to turn on automatically when high temperature conditions exist. These
conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive (see Mass storage devices on page 44)

c. Top cover (see Top cover on page 46)

Remove the fan:

1. Disconnect the fan cable (1).

2. Remove the 2 Phillips PM2.5×4.0 screws (2) that secure the fan to the base enclosure.
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3. Remove the fan (3).

Reverse this procedure to install the fan.
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Heat sink assembly

Description Spare part number

Heat sink assembly (includes replacement thermal material) 537619-001

Before removing the heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive (see Mass storage devices on page 44)

c. Top cover (see Top cover on page 46)

d. WLAN module (see WLAN module on page 49)

e. Fan (see Fan on page 56)

Remove the heat sink assembly:

1. Remove the 4 Phillips PM1.6×2.5 screws (1) that secure the heat sink assembly to the system
board.

NOTE: The screws are numbered 1 through 4. Follow this order when removing the screws.

58 Chapter 4   Removal and replacement procedures



2. Remove the heat sink assembly (2).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink
assembly and system board components, it may be necessary to move the heat sink assembly from
side to side to detach the assembly.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
assembly and the system board each time the heat sink assembly is removed. Thermal paste is
used on the processor (1), and thermal tape is used on the Northbridge chip (2). Replacement
thermal material is included with all heat sink assembly and system board spare part kits.

Reverse this procedure to install the heat sink assembly.
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System board

Description Spare part number

System board (includes processor and replacement thermal material)  

● Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus (FSB) 594804-001

● Intel Atom N270 1.6-GHz processor, 512-KB Level 2 cache, 533-MHz front-side bus (FSB) for
use with WWAN option

599187-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive (see Mass storage devices on page 44)

c. Top cover (see Top cover on page 46)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● WLAN module (see WLAN module on page 49)

● WWAN module, if included (see WWAN module on page 52)

● RTC battery (see RTC battery on page 43)

● Heat sink assembly (see Heat sink assembly on page 58)

Remove the system board:

1. Release the tape securing the WWAN antennas (1).
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2. Disconnect the following cables from the system board:

(2) Display panel cable

(3) Microphone cable

(4) Speaker cable

(5) WLAN cables

(6) WWAN cables (select models only)

3. Remove the 2 Phillips PM1.6×2.0 screws (1) that secure the actuators for the power switch and
wireless on/off switch to the system board.

4. Remove the actuators (2).

Component replacement procedures 61



5. Remove the 3 Phillips PM2.5×4.0 screws that secure the system board to the base enclosure.

6. Grasp the system board at the midpoint of the left side (1), and lift it up.

7. Pull the system board (2) out to the left at an angle to remove it.

8. Remove the system board.

Reverse the procedure to install the system board.
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Display assembly
NOTE: Each display assembly spare part kit includes 1 webcam, 1 microphone, 2 speakers, and 2
WLAN antenna assemblies; 2 WWAN antenna assemblies on select models.

Description Spare part number

Display assembly, 25.7-cm (10.1-in), WSVGA, AntiGlare for use with WWAN 594806-001

Display panel, 25.7-cm (10.1-in), WSVGA, non-PMMA, AntiGlare, LED 600125-001

Hinge covers 537617-001

Display bezel with logo for use with webcam and microphone 537644-001

Display hinge kit

Includes left and right display panel hinges

537658-001

Speaker assembly

Includes 2 speakers, cable, and housing

594811-001

Webcam module 537660-001

Display cable kit

Includes display/webcam cable and WLAN antennas

579571-001

Microphone assembly (44 dB, 4.9 × 2.2, omnidirectional) 581323-001

WWAN antenna assemblies with cables 538022-001

Display back cover with logo 594808-001

Display screw kit (not illustrated) 538510-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. If your computer has WWAN capability, remove the SIM (see SIM on page 37).

6. Remove the following components:

a. Keyboard (see Keyboard on page 40)

b. Hard drive (see Mass storage devices on page 44)

c. Top cover (see Top cover on page 46)
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Remove the display assembly:

1. Release the tape securing the WWAN antennas (1).

2. Disconnect the following cables from the system board:

(2)  Display panel cable

(3) Microphone cable

(4) Speaker cable

(5) WLAN cables

(6) WWAN cables (select models only)

CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other computer
components.

3. Remove the 4 Phillips PM2.5×4.0 screws (1) that secure the display assembly to the computer.

NOTE: One screw on the left hinge (2) also secures the display panel cable ground strap.
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4. Remove the display assembly (3).

5. If it is necessary to replace the display bezel, perform the following steps:

a. Remove the display hinge covers (1).

b. Flex the inside edges of the top and bottom (2), and then the left and right sides (3) of the
display bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel (4).
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6. If it is necessary to replace the display panel, perform the following steps:

a. Remove the 7 Phillips PM2.0×3.0 screws that secure the display panel to the display
enclosure.

b. Lift the display panel up from the display enclosure (1).

c. Disconnect the webcam cable (2) from the system board (2)

d. Remove the display panel (3) from the display enclosure.

7. If it is necessary to replace the speaker assembly, perform the following steps:

a. Remove the two Phillips PM2.0×3.0 screws (1) that secure the speaker assembly to the
display enclosure.
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b. Remove the speaker assembly (2).

8. If it is necessary to replace the display hinges, perform the following steps:

a. Remove the 2 Phillips PM2.0×3.0 screws (1) that secure each hinge to the display enclosure.

b. Remove the hinges (2).

9. If it is necessary to replace the display panel cable, perform the following steps:

a. Peel back the Mylar protection on the back of the display panel (1).
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b. Disconnect the display panel cable (2).

10. If it is necessary to replace the webcam module, perform the following steps:

a. Disconnect the webcam cable (1) from the webcam.

b. Remove the webcam (2).

11. If it is necessary to replace the microphone receiver, perform the following steps:

a. Release the microphone receiver from the clip (1) that secures it to the display enclosure.
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b. Pull the receiver through the tabs (2), and remove the microphone receiver (3).

12. If it is necessary to replace the wireless antenna transceivers and cables, detach the cables from
the adhesive (1) that secures them to the display enclosure, and then remove the cables (2).

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup

Computer Setup in Windows 7
Starting the Setup Utility

The Setup Utility is a ROM-based information and customization utility that can be used even when your
Windows operating system is not working.

The utility reports information about the device and provides settings for startup, security, and other
preferences.

To start the Setup Utility:

▲ Open the Setup Utility by turning on or restarting the device, and then pressing f10 while the “F10
= BIOS Setup Options” message is displayed in the lower-left corner of the screen.

Using the Setup Utility

Changing the language of the Setup Utility

The following procedure explains how to change the language of the Setup Utility. If the Setup Utility is
not already running, begin at step 1. If the Setup Utility is already running, begin at step 2.

1. Open the Setup Utility by turning on or restarting the device, and then pressing f10 while the “F10
= BIOS Setup Options” message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select System Configuration > Language, and then press enter.

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.

5. To save your change and exit the Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change goes into effect immediately.
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Navigating and selecting in the Setup Utility

Because the Setup Utility is not Windows based, it does not support the TouchPad. Navigation and
selection are by keystroke.

● To choose a menu or a menu item, use the arrow keys.

● To choose an item in a list or to toggle a field, for example an Enable/Disable field, use either the
arrow keys or f5 or f6.

● To select an item, press enter.

● To close a text box or return to the menu display, press esc.

● To display additional navigation and selection information while the Setup Utility is open, press f1.

Displaying system information

The following procedure explains how to display system information in the Setup Utility. If the Setup
Utility is not open, begin at step 1. If the Setup Utility is open, begin at step 2.

1. Open the Setup Utility by turning on or restarting the device, and then pressing f10 while the “F10
= BIOS Setup Options” message is displayed in the lower-left corner of the screen.

2. Select the Main menu. System information such as the system time and date, and identification
information about the device is displayed.

3. To exit the Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.

Restoring default settings in the Setup Utility

The following procedure explains how to restore the Setup Utility default settings. If the Setup Utility is
not already running, begin at step 1. If the Setup Utility is already running, begin at step 2.

1. Open the Setup Utility by turning on or restarting the device, and then pressing f10 while the “F10
= BIOS Setup Options” message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select Exit > Load Setup Defaults, and then press enter.

3. When the Setup Confirmation is displayed, press enter.

4. To save your change and exit the Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

The Setup Utility default settings go into effect when the device restarts.

NOTE: Your password, security, and language settings are not changed when you restore the factory
default settings.
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Exiting the Setup Utility

You can exit the Setup Utility with or without saving changes.

● To exit the Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Saving Changes, and then press enter.

● To exit the Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Discarding Changes, and then press enter.

After either choice, the device restarts in Windows.

Setup Utility menus
The menu tables in this section provide an overview of Setup Utility options.

NOTE: Some of the Setup Utility menu items listed in this chapter may not be supported by your
device.

Main menu

Select To do this

System information ● View and change the system time and date.

● View identification information about the device.

● View specification information about the processor, memory size,
and system BIOS.

Security menu

Select To do this

Administrator password Enter, change, or delete an administrator password.

Power-On Password Enter, change, or delete a power-on password.

System Configuration menu

Select To do this

Language Support Change the Setup Utility language.
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Select To do this

Processor C4 State Enable/disable the processor C4 sleep state.

Boot Options Set the following boot options:

● f10 and f12 Delay (sec.)―Set the delay for the f10 and f12
functions of the Setup Utility in intervals of 5 seconds each (0, 5,
10, 15, 20).

● Internal Network Adapter boot―Enable/disable boot from Internal
Network Adapter.

● Boot Order―Set the boot order for:

◦ Internal hard drive (select models only)

◦ USB Floppy

◦ USB CD/DVD ROM Drive

◦ USB flash drive

◦ USB Hard drive

◦ USB Card Reader

◦ Network adapter

NOTE: Only the devices attached to the system will appear
in the boot order menu.

Diagnostics menu

Select To do this

Hard Disk Self Test (select models only) Run a comprehensive self-test on the hard drive.

Memory Test Run a diagnostic test on the system memory.
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Computer Setup in Windows XP
Starting Setup Utility

Setup Utility is a ROM-based information and customization utility that can be used even when your
Windows operating system is not working.

The utility reports information about the computer and provides settings for startup, security, and other
preferences.

To start Setup Utility:

▲ Open Setup Utility by turning on or restarting the computer, and then pressing f10 while the “F10
= BIOS Setup Options” message is displayed in the lower-left corner of the screen.

Using Setup Utility

Changing the language of Setup Utility

The following procedure explains how to change the language of Setup Utility. If Setup Utility is not
already running, begin at step 1. If Setup Utility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer, and then pressing f10 while the “F10
= BIOS Setup Options” message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select System Configuration > Language, and then press enter.

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.

5. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change goes into effect immediately.

Navigating and selecting in the Setup Utility

Because Setup Utility is not Windows based, it does not support the TouchPad. Navigation and
selection are by keystroke.

● To choose a menu or a menu item, use the arrow keys.

● To choose an item in a list or to toggle a field, for example an Enable/Disable field, use either the
arrow keys or f5 or f6.

● To select an item, press enter.

● To close a text box or return to the menu display, press esc.

● To display additional navigation and selection information while the Setup Utility is open, press f1.
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Displaying system information

The following procedure explains how to display system information in the Setup Utility. If the Setup
Utility is not open, begin at step 1. If the Setup Utility is open, begin at step 2.

1. Open the Setup Utility by turning on or restarting the computer, and then pressing f10 while the
“F10 = BIOS Setup Options” message is displayed in the lower-left corner of the screen.

2. Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

3. To exit the Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.

Restoring default settings in the Setup Utility

The following procedure explains how to restore the Setup Utility default settings. If the Setup Utility is
not already running, begin at step 1. If the Setup Utility is already running, begin at step 2.

1. Open the Setup Utility by turning on or restarting the computer, and then pressing f10 while the
“F10 = BIOS Setup Options” message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select Exit > Load Setup Defaults, and then press enter.

3. When the Setup Confirmation is displayed, press enter.

4. To save your change and exit the Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

The Setup Utility default settings go into effect when the computer restarts.

NOTE: Your password, security, and language settings are not changed when you restore the factory
default settings.

Exiting the Setup Utility

You can exit the Setup Utility with or without saving changes.

● To exit the Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Saving Changes, and then press enter.

● To exit the Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Discarding Changes, and then press enter.

After either choice, the computer restarts and loads the operating system.

Setup Utility menus
The menu tables in this section provide an overview of Setup Utility options.

NOTE: Some of the Setup Utility menu items listed in this chapter may not be supported by your
computer.
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Main menu

Select To do this

System information ● View and change the system time and date.

● View identification information about the computer.

● View specification information about the processor, memory size,
and system BIOS.

Security menu

Select To do this

Administrator password Enter, change, or delete an administrator password.

Power-On Password Enter, change, or delete a power-on password.

System Configuration menu

Select To do this

Language Support Change the Setup Utility language.

Processor C4 State Enable/disable the processor C4 sleep state.

Boot Options Set the following boot options:

● f10 and f12 Delay (sec.)―Set the delay for the f10 and f12
functions of the Setup Utility in intervals of 5 seconds each (0, 5,
10, 15, 20).

● Internal Network Adapter boot―Enable/disable boot from Internal
Network Adapter.

● Boot Order―Set the boot order for:

◦ Internal hard drive (select models only)

◦ USB Floppy

◦ USB CD/DVD ROM Drive

◦ USB flash drive

◦ USB Hard drive

◦ USB Card Reader

◦ Network adapter

NOTE: Only the devices attached to the system will appear
in the boot order menu.
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Diagnostics menu

Select To do this

Hard Disk Self Test (select models only) Run a comprehensive self-test on the hard drive.

Memory Test Run a diagnostic test on the system memory.
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6 Specifications

Computer specifications
Dimensions

Depth 16.67 cm (6.56 in)

Width 26.17 cm (10.30 in)

Height 2.52 cm (0.99 in)

Weight

25.7-cm (10.1-in) LCD, equipped with a 3-cell battery, hard
drive, 1-GB memory, WLAN module, and 2 wireless antennas

1.17 kg (2.57 lbs)

Input power

Operating voltage 19 V dc @ 1.58 A - 30 W

Operating current 1.58 A

Temperature

Operating 5°C to 35°C (41°F to 95°F)

Nonoperating -20°C to 65°C (-4°F to 149°F)

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 0% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m (-50 ft to 10,000 ft)

Nonoperating -15 m to 12,192 m (-50 ft to 40,000 ft)

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate
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Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep
rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.
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25.7-cm (10.1-in), WSVGA, AntiGlare display
specifications

Dimensions  

Height 12.53 cm (4.93 in)

Width 22.27 cm (8.77 in)

Diagonal 25.55 cm (10.06 in)

Number of colors 262,144

Contrast ratio 400:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.2175 × 0.2175 mm

Format 1024 × 600

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 3.0 W

Viewing angle ±40° horizontal, +20/-40° vertical (typical)
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Hard drive specifications
 160-GB*

Dimensions

Height 9.5 mm (0.37 in)

Width 70 mm (2.76 in)

Weight 101 g (3.56 oz)

Interface type SATA

Transfer rate 100 MB/sec

Security ATA security

Seek times (typical read, including setting)

Single track 3 ms

Average 13 ms

Maximum 24 ms

Logical blocks 117,210,240

Disc rotational speed 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

* 1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Solid-state drive specifications
Performance

Transfer modes supported UDMA 0-4, Multiword-DMA 0-2, PIO 0-4

Read 94902 KB/sec

Write 26743 KB/sec

Characteristics

Interface Serial ATA revision 2.6

Flash type MLC (LBG) NAND

Flash capacity 16 GB

Electrical specifications

DC supply voltage 5.0 V ±5%

Standby current 130 mA (typical)

Active current Read = 210.1 mA (average)

Write = 225.9 mA (average)

Environmental specifications

Operating temperature 0°C to +70°C (32°F to 158°F)

Storage temperature -40°C to +85°C (-40°F to 185°F)

Operating altitude up to 24,384 m (80,000 feet)

Humidity 5% to 90% non-condensing

Shock 1,000 g

Acoustic noise 0 dB

Vibration 15 g (peak to peak)

Physical specifications

Connector 7+15 pin SATA connector

Weight 8.5 ±1 g

Dimensions 54 × 39 × 6.4 mm (2.13 × 1.54 × 0.25 in)

Regulations and compliance RoHS, China RoHS, SGS ROHS, FCC, CE
UL – PCB Only
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System resource specifications
You can use Device Manager to get a graphical view of the system resources that control how the
devices work on the computer. System resources you can access from Device Manager are direct
memory access (DMA) channels, input/output (I/O) ports, interrupt request (IRQ) lines, and memory
addresses.

If two devices require the same resource and create a device conflict, you can manually change the
resource settings in Device Manager to be sure each setting is unique.

CAUTION: Improperly changing resource settings can disable your hardware and cause your
computer to malfunction or become inoperable. Only users who have expert knowledge of computer
hardware and hardware configurations should change resource settings.

To view resource settings in Windows 7 and Windows Vista:

1. Select Start > Computer.

2. Click System properties near the top of the Computer folder.

3. On the left, click Device Manager.

4. On the View menu, click one of the following:

● Resources by type

● Resources by connection

To view resource settings in Windows XP:

1. Select Start > My Computer, or double-click My Computer on the desktop.

2. Under System Tasks, click View system information.

3. In the System Properties window, select the Hardware tab.

4. Click Device Manager.

5. On the View menu, click one of the following:

● Resources by type

● Resources by connection
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7 Backup and recovery

Select the section in this chapter that applies to the operating system installed on your computer.
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Windows 7 backup and recovery
Use the instructions in the section if Windows 7 is installed on your computer.

To protect your information, back up your files and folders. In case of system failure, you can use the
backup files to restore your computer.

CAUTION: In the event of a hard drive failure, you cannot use your computer to access the Disaster
Recovery utility. Therefore, HP recommends that you download the Disaster Recovery utility SoftPaq,
and then extract it to a USB flash drive as soon as possible after software setup. For details, refer to
“Downloading and extracting the Disaster Recovery utility” later in this chapter.

Depending on your computer model, you may have one of the following backup and recovery
solutions:

● Roxio BackOnTrack

● HP Recovery Manager

NOTE: For detailed information, perform a search for these topics in Help and Support.

Backing up and recovering using Roxio BackOnTrack
Successful recovery after a system failure depends on whether you have completely backed up your
files. If Roxio BackOnTrack is preinstalled on your computer, BackOnTrack allows you to create a
backup of your computer image. You should create the initial backup immediately after software setup.
As you add new software and data files, you should continue to back up your system on a regular
basis to maintain a reasonably current backup.

Note the following guidelines when backing up your information:

● Store personal files in the Documents library and back up this folder regularly.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document, follow these steps:

1. Display the screen.

2. Copy the screen:

● To copy the active window, press alt+fn+prt sc.

● To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, select Edit>Paste.

4. Save the document.
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Creating a copy of the hard drive

The back up drive function of BackOnTrack creates a Disaster Recovery Set that is an exact image of
your hard drive data. You can back up the image to an external hard drive (purchased separately).

To create a Disaster Recovery Set using BackOnTrack, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

1. Select Start>All Programs> Roxio.

2. SelectBackOnTrack>BackOnTrack Home>Disaster Recovery.

3. Select Backup drive.

4. Select a drive to back up.

5. Add a comment to describe the backup.

NOTE: Comments are optional, but adding comments can help you remember the purpose of
the backup. The date and list of drives being backed up are automatically included in the
description.

6. Select a destination for the Disaster Recovery Set.

NOTE: The destination cannot be a network drive.

7. Select the action button at the bottom-right of the computer screen.

8. Follow the on-screen instructions.

Performing a recovery

In case of system failure or instability, the computer provides the following ways to recover your files:

● BackOnTrack Disaster Recovery utility: You can use Disaster Recovery to recover your hard drive
image (including your files, programs, and operating system) after a hard drive failure.

● BackOnTrack Instant Restore utility: You can use Instant Restore to quickly restore your computer to
a working state if a software-related problem occurs. The Instant Restore utility automatically
creates working states periodically. You can also define a working state by saving the current
computer state manually.

NOTE: For more information about computer system states, refer to the BackOnTrack software help.

Using the Disaster Recovery utility

NOTE: To perform a recovery with Disaster Recovery, you need a USB flash drive (purchased
separately). For optimum performance, the capacity of the drive should be no larger than 2 GB.

Disaster Recovery recovers data from a Disaster Recovery Set that you previously created with Roxio
BackOnTrack. Disaster Recovery is available from the HP Web site in a compressed file called a
SoftPaq.

NOTE: Running the SoftPaq makes the USB drive bootable.
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CAUTION: Before performing a disaster recovery, you must download the Disaster Recovery utility
and extract it to a USB flash drive.

Downloading and extracting the Disaster Recovery utility

To download and extract Disaster Recovery, follow these steps:

1. Connect a bootable USB flash drive or external drive to a USB port on your computer.

2. Open your Web browser, go to http://www.hp.com/support, and select your country or region.

3. Enter the SoftPaq number SP42226 in the Search box, press enter, and then follow the on-screen
instructions.

4. Select Download only to save the file to your computer.

5. When prompted, select Save, and then select the external drive from the list of storage locations.

6. After the file is downloaded, navigate to the USB flash drive or external drive, and then double-
click the SoftPaq file to format the USB flash drive and extract the Disaster Recovery files.

7. If prompted to do so, restart your computer after the installation is complete.

Restoring your hard drive image

To restore your hard drive image using Disaster Recovery, follow these steps:

1. Connect the external hard drive containing the Disaster Recovery Set to your computer.

2. Connect the bootable USB flash drive containing the extracted Disaster Recovery utility to a USB
port on your computer.

3. Change the boot device order by turning on or restarting the computer, and then press f9.

4. Use the arrow keys to select the USB flash drive, and then press enter.

5. At the Roxio BackOnTrack Disaster Recovery screen, select Disaster Recovery>Next.

6. Browse to the external hard drive containing the Disaster Recovery Set, and then select Next.

7. Select Next to proceed with the recovery.

NOTE: This process may take several minutes.

8. After a message on the screen reports a successful recovery, select Finish.

Using the Instant Restore utility

You can restore your computer from Windows when the operating system is functioning. If the
operating system is not functioning, you can also access the utility by restarting your computer.

NOTE: For more information about the Instant Restore utility, refer to the BackOnTrack software Help.
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Using the Instant Restore utility when the operating system is functioning

To recover information when the operating system is functioning properly, follow these steps:

1. Save and close all open documents and close any open programs.

2. Select Start>All Programs>Roxio.

3. Select BackOnTrack>BackOnTrack Home>Instant Restore.

4. Select Restore State, and then select a restore state.

5. Select the action button in the bottom-right corner of the computer screen.

6. Select Yes to confirm your selected restore state.

When the restore process is complete, the computer restarts and a notification message is displayed.

Using the Instant Restore utility when the operating system is not functioning

To recover information when the operating system is not functioning, follow these steps:

1. Restart the computer.

NOTE: If the operating system has stopped responding and the computer screen is blue, restart
the computer by turning the power switch off and then on.

2. When the computer logo (HP or Compaq) is displayed on the screen, press the f6 button
repeatedly until the Windows status bar is displayed.

3. When the Roxio BackOnTrack screen is displayed, follow the on-screen instructions.

Using Windows Backup and Restore
To create a backup using Windows Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start>All Programs>Maintenance>Backup and Restore.

2. Follow the on-screen instructions to set up and create a backup.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Using system restore points

When you back up your system, you are creating a system restore point. A system restore point allows
you to save and name a snapshot of your hard drive at a specific point in time. You can then revert
back to that point if you want to reverse subsequent changes made to your system.
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NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created since
the last restore point.

You also can create additional restore points to provide increased protection for your system files and
settings.

When to create restore points

● Before you add or extensively modify software or hardware.

● Periodically, whenever the system is performing optimally.

NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.

Creating a system restore point

1. Select Start>Control Panel>System and Security>System.

2. In the left pane, select System protection.

3. Select the System Protection tab.

4. Under Protection Settings, select the disk for which you want to create a restore point.

5. Select Create.

6. Follow the on-screen instructions.

Restoring to a previous date and time

To revert to a restore point (created at a previous date and time) when the computer was functioning
optimally, follow these steps:

1. Select Start>Control Panel>System and Security>System.

2. In the left pane, select System protection.

3. Select the System Protection tab.

4. Select System Restore.

5. Follow the on-screen instructions.

Backing up and recovering using HP Recovery Manager
If your computer includes HP Recovery Manager, tools provided by the operating system and by HP
Recovery Manager software are designed to help you with the following tasks for safeguarding your
information and restoring it in case of a system failure:

● Backing up your information

● Creating a set of recovery discs

● Creating system restore points
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● Recovering a program or driver

● Performing a full system recovery

Backing up your information

As you add new software and data files, you should back up your system on a regular basis to
maintain a reasonably current backup. Back up your system at the following times:

● At regularly scheduled times

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Note the following when backing up:

● Create system restore points using the Windows System Restore feature, and periodically copy
them to a disc.

● Store personal files in the Documents library, and periodically back up this folder.

● Back up templates stored in their associated programs.

● You can back up your information to an optional external hard drive, a network drive, or discs.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD-R, or DVD±RW. The discs you use depend on the type of optical drive you
are using.

NOTE: DVDs store more information than CDs, so using them for backup reduces the number of
recovery discs required.

● When backing up to discs, number each disc before inserting it into an optical drive.

● Save the customized settings in a window, toolbar, or menu bar by taking a screen shot of the
settings. The screen shot can be a time-saver if you have to reset your preferences.

To copy the screen and paste the image into a word-processing document:

1. Display the screen.

2. Copy the screen:

To copy only the active window, press alt+prt sc.

To copy the entire screen, press prt sc.

3. Open a word-processing document, select Edit> Paste.

4. Save the document.
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Creating a set of recovery discs

HP recommends that you create recovery discs to be sure that you can restore your system to its original
factory state if you experience serious system failure or instability. Create these discs after setting up the
computer for the first time.

NOTE: This task will require an optional external or shared optical drive.

Handle these discs carefully and keep them in a safe place. The software allows the creation of only
one set of recovery discs.

Note the following guidelines before creating recovery discs:

● You will need high-quality DVD-R, DVD+R, BD-R (writable Blu-ray), or CD-R discs. All these discs
are purchased separately. DVDs have a larger storage capacity than CDs. If you use CDs, up to
20 discs may be required, whereas only a few DVDs are required.

NOTE: Double-layer discs and read-write discs—such as CD-RW, DVD±RW, and BD-RE
(rewritable Blu-ray) discs—are not compatible with the Recovery Manager software.

● The computer must be connected to AC power during this process.

● Only one set of recovery discs can be created per computer.

● Number each disc before inserting it into an optical drive.

● If necessary, you can exit the program before you have finished creating the recovery discs. The
next time you open Recovery Manager, you will be prompted to continue the disc creation
process.

To create a set of recovery discs:

1. Select Start>All Programs>Recovery Manager>Recovery Disc Creation.

2. Follow the on-screen instructions.

Performing a recovery
NOTE: You can recover only files that you have previously backed up. HP recommends that you use
Recovery Manager to create a set of recovery discs (entire drive backup) as soon as you set up your
computer.

Recovery Manager software allows you to repair or restore the system if you experience system failure
or instability. Recovery Manager works from recovery discs that you create or from a dedicated
recovery partition (select models only) on the hard drive. However, computers that include a solid-state
drive (SSD) may not have a recovery partition. If that is the case, recovery discs have been included
with your computer. Use these discs to recover your operating system and software.

NOTE: Windows has its own built-in repair features, such as System Restore. If you have not already
tried these features, try them before using Recovery Manager. For more information on these built-in
repair features, select Start>Help and Support.

NOTE: Recovery Manager recovers only the software that was preinstalled at the factory. Software
not provided with this computer must be downloaded from the manufacturer’s Web site or reinstalled
from the disc provided by the manufacturer.
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Recovering using the recovery discs

To restore the system from the recovery discs:

1. Back up all personal files.

2. Insert the first recovery disc into an optional optical drive, and restart the computer.

3. Follow the on-screen instructions.

Recovering using the partition on the hard drive (select models only)

On some models, you can perform a recovery from the partition on the hard drive, which is accessed
by pressing either the Start button or f11. This restores the computer to its factory condition.

NOTE: Computers with an SSD may not have a recovery partition. If the computer does not have a
recovery partition, you will not be able to recover using this procedure. Recovery discs have been
included for computers that do not have a partition. Use these discs to recover your operating system
and software.

To restore the system from the partition, follow these steps:

1. Access Recovery Manager in either of the following ways:

Select Start>All Programs>Recovery Manager>Recovery Manager.

– or –

a. Turn on or restart the computer.

b. Press f11 while the “Press f11 for recovery message is displayed on the screen.

NOTE: It may take several minutes for Recovery Manager to load.

2. In the Recovery Manager window, select System Recovery.

3. Follow the on-screen instructions.
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Windows XP backup and recovery
Use the instructions in this section if Windows XP is installed on your computer.

To protect your information, use the Windows® Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, select Edit > Paste.

The screen image is added to the document.

d. Save the document.
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To create a backup using the Windows Backup utility (select models only), follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information

To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Select Restore files and settings >Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this
topic in Help and Support.

Recovering the operating system and programs

CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

94 Chapter 7   Backup and recovery



6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.

Windows XP backup and recovery 95



8 Connector pin assignments

Audio-out (headphone)/Audio-in (microphone) jack

Pin Signal

1 Left audio signal in

2 Right audio signal in

3 Ground

4 Microphone
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter, spare part

number 24
administrator password 72, 76
antenna

removal 69
spare part number 21, 63

antennas 14
applications key, Windows 7
audio, product description 2
audio-in (microphone) jack 11
audio-out (headphone) jack 11
audio-in jack

pin assignments 96
audio-out jack

pin assignments 96

B
base enclosure, spare part

number 19
battery

removal 36
spare part number 20, 36

battery bay, identifying 13
battery light 8
battery release latches 13
bay, battery 13
boot options 73, 76
boot order 73, 76
buttons

left TouchPad 5
right TouchPad 5

C
cables, service considerations 29
caps lock light, identifying 6
changing Setup Utility

language 74
changing the Setup Utility

language 70

chipset, product description 1
compartment, memory module 13
components

bottom 13
display 12
front 8
left-side 11
right-side 10
TouchPad 5

computer feet
locations 35
spare part number 35

computer specifications 78
connectors

service considerations 29

D
Diagnostics menu 73, 77
Digital Media Slot, identifying 10
discs

Driver Recovery 94
Operating System 94

diskette drive
precautions 30
product description 2

display assembly
removal 63
spare part number 16, 63

display bezel
illustrated 21, 63
removal 65
spare part number 21, 63

display cable kit, spare part
number 21, 63

display component recycling 102
display enclosure

illustrated 22, 63
spare part number 22, 63

display hinge kit, spare part
number 21, 63

display hinge, removal 67
display panel

illustrated 21
removal 66
spare part number 21

display panel screws 22
display screw kit, spare part

number 22, 63
display specifications 80
display switch, identifying 12
displaying system

information 71, 75
drive light, identifying 8
Driver Recovery disc 94
drives

preventing damage 30
drives, boot order 73, 76

E
earbuds 11
electrostatic discharge 31
Ethernet, product description 2
exiting the Setup Utility 72, 75
external media cards, product

description 3
external monitor port

pin assignments 97
external monitor port,

identifying 10

F
fan

removal 56
spare part number 17, 56

feet
locations 35
spare part number 35

fn key 7
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function keys 7

G
graphics, product description 1
grounding equipment and

methods 33

H
hard drive

precautions 30
product description 2
spare part number 17
specifications 81

hard drive self test 73, 77
headphone (audio-out) jack 11
headphone jack

pin assignments 96
headphones 11
heat sink assembly

removal 58
spare part number 58

hinge covers
illustrated 21, 63
spare part number 21, 63

I
internal display switch,

identifying 12
internal media cards, product

description 3
internal microphone,

identifying 12

J
jacks

audio-in (microphone) 11
audio-out (headphone) 11
RJ-45 (network) 10

K
keyboard

product description 3
removal 40
spare part number 17, 40

keys
fn 7
function 7
Windows applications 7
Windows logo 7

L
language support 72, 76
latches, battery release 13
left TouchPad button, identifying 5
lights

battery 8
caps lock 6
drive 8
power 8
webcam 12
wireless 9

M
Main menu 72, 76
mass storage device

product description 2
spare part number 17

mass storage devices
illustrated 44
spare part numbers 44

memory module
product description 1
removal 38
spare part number 19, 38

memory module compartment cover
removal 38

memory module compartment,
identifying 13

memory test 73, 77
microphone (audio-in) jack 11
microphone assembly, spare part

number 21, 63
microphone jack

pin assignments 96
model name 1
modem, product description 2
monitor port

pin assignments 97

N
navigating in the Setup

Utility 71, 74
network jack

pin assignments 98
network jack, identifying 10

O
Operating System disc 94
operating system, product

description 3

optical drive, product
description 2

P
packing guidelines 32
panels, product description 1
passwords 72, 76
pin assignments

audio-in jack 96
audio-out jack 96
external monitor port 97
headphone jack 96
microphone jack 96
monitor port 97
network jack 98
RJ-45 jack 98
Universal Serial Bus (USB)

port 99
plastic parts 29
pointing device

product description 3
ports

product description 3
USB 10, 11

power connector, identifying 11
power cord

set requirements 100
spare part number 24

power light, identifying 8
power requirements, product

description 3
power switch, identifying 8
power-on password 72, 76
Processor C4 State 73, 76
processor, product description 1
product description

audio 2
chipset 1
diskette drive 2
Ethernet 2
external media cards 3
graphics 1
internal media cards 3
keyboard 3
mass storage device 2
memory module 1
modem 2
operating system 3
optical drive 2
panels 1
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pointing device 3
ports 3
power requirements 3
processors 1
product name 1
security 3
serviceability 4
wireless 2

product name 1

R
release latches, battery 13
removal/replacement

preliminaries 29
procedures 34

restoring default settings 71, 75
right TouchPad button,

identifying 5
RJ-45 (network) jack,

identifying 10
RJ-45 jack

pin assignments 98
RTC battery

removal 43
spare part number 19, 43

rubber kit, spare part number 24

S
screw count 34
screw kit

spare part number 24
screws

PM1.6×2.0 61
PM1.6×2.5 58
PM2.0×3.0 41, 44, 51, 52

, 66, 67
PM2.0×3.0 captive 38
PM2.0×3.0×4.0×0.4T 22
PM2.0×4.0 46
PM2.5×10.0 captive 44
PM2.5×4.0 55, 56, 62, 64
PM2.5×6.0 46, 47
PM3.0×3.0 27, 45

security cable slot, identifying 11
Security menu 72, 76
security, product description 3
selecting in the Setup

Utility 71, 74
serial number 15, 34
service considerations 29

service tag 15, 34
serviceability, product

description 4
SIM

removal 37
solid state drive

product description 2
solid-state drive 82
speaker assembly

illustrated 21, 63
removal 66
spare part number 21, 63

speakers, identifying 12
specifications

computer 78
display 80
hard drive 81
solid-state drive 82
system resources 83

static-shielding materials 33
switches

power 8
wireless 9

system board
removal 60
spare part number 19, 60

System Configuration
menu 72, 76

system information 72, 76
system resources 83

T
tools required 29
top cover

removal 46
spare part number 17, 46

TouchPad
buttons 5
identifying 5

TouchPad scroll zone,
identifying 5

transporting guidelines 32

U
USB board

removal 54
spare part number 54

USB board, spare part
number 18, 54

USB port
pin assignments 99

USB ports, identifying 10, 11

V
ventilation clearance 56
vents, identifying 11, 13

W
webcam light, identifying 12
webcam module

illustrated 21, 63
removal 68
spare part number 21, 63

webcam, identifying 12
Windows applications key,

identifying 7
Windows Backup utility 93, 94
Windows logo key, identifying 7
Windows recovery 94
wireless antenna

removal 69
spare part number 21, 63

wireless antennas 14
wireless light, identifying 9
wireless module, product

description 2
wireless switch, identifying 9
WLAN antennas, identifying 14
WLAN module

removal 49
spare part number 18, 49

workstation guidelines 32
WWAN antennas, identifying 14
WWAN module

removal 52
spare part number 19, 52
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